
 
 

I’m New To This?  Can I Do It? 

First, let's get a few things straight.  You are not alone.  The idea of taking your favorite 
records and saving them to CD is not a new idea.  In fact, we've made it our business 
since 1995.  The only thing that's changed since then has been the advent of better and 
faster technology for accomplishing the task.    

Is it easy?  Certainly. 

Can you do it?  Again...certainly. 

Our customers are all of an age where they basically grew up without computers, so 
we've designed our products with folks just like you in mind.  Our software, which does 
most of the work is designed much like a tape recorder...only much more powerful.  This 
software is a tool, not unlike your first electric drill.  It will take you a few minutes to get 
up to speed and then you'll be productive.  In a few weeks, you'll be an expert.  

This tutorial will walk you through the entire process from A-CD.  It will tell you what 
you'll need...it will make suggestions that take into account the quality you're looking for 
and the budget you're looking to hit.   

In the end, you'll have a collection of CDs that sound better than the original vinyl they 
were produced on. Along the way, you'll have a great time reliving the memories those 
precious recordings evoke. 

We'll break this into short chapters.  Feel free to print things out and read them at your 
leisure.  And of course, you can always feel free to call us toll free and we'll help with 
any questions you might have.  Our number is 866 260 6376 and unlike most Internet 



companies today...we actually answer the phones and our emails.  Crazy isn't it.  People 
who actually help you before and after you buy our products.   

Chapter 1- The Basics   

This chapter will explain the basics of the task you've chosen to undertake.  It will 
describe the various components you'll need to have a simple recording system on your 
PC. 

Chapter 2- Getting Hooked Up 

This chapter will tell you what to do once you have the components you need.  This will 
get things wired up and ready to go. 

Chapter 3- Making Your First Recording 

Let's launch the software and make our first recording.  This will also help you 
troubleshoot any problems you might encounter along the way.   

Chapter 4- How The Tools Work 

Now the fun begins.  You've recorded a song or songs to the hard disk...let's start 
cleaning. 

Chapter 5- Finishing The Project 

You've cleaned the noise...now let's finish it. 

Chapter 6- Expanding Your Setup 

Pretty fun isn't it?  How can you make things better?  This chapter explains ways that you 
can make your system better and achieve even more stunning results.   

Chapter 1.  The Basics 
Let's determine what you'll need at the very least to get started transferring your treasured 
vinyl recordings to CD.  At this point, quality is not really the issue...lets' just focus on 
the basic elements of the recording system and we'll get into more detail further down 
this list.  

A.  You'll need a computer.  The fact that you've downloaded this from a computer 
gives us the important clue that you're probably okay in that area.  In the world of 
computers, faster is always better, but it's safe to say, that if you've bought this computer 
in the last several years and have either Windows 98SE, 2K, ME, XP or Vista, then one 
of our solutions will work for you.  Computers today are designed to handle video 
recording and playback...our little audio files will seem like child's play to them.  No 



special graphics or RAM needed...Let's check this off the list.  Tracer also offers a great 
lineup of fast new computers that are custom built for audio, but with your wallet in 
mind.    Just click on the following link if you need a new computer.  If not, you may 
want to investigate the Tracer Technologies AudioCenter PC.  We hand build these 
lightning fast PCs exactly to your specs and you might be surprised at the price.  Call us 
at 866 260 6376 to discuss your system needs. 

B. You'll need a turntable.  Nothing fancy here.  The turntable that has served you well 
in the last 20 years is probably just fine to complete this transfer.  Don't even worry 
so much about the speeds of your turntable.  If it supports any of the following...78, 
45, or 33 1/3, you're good to go.  Our software can take care of speed issues.  For 
example, if you have only 45 and 33 1/3 speeds available, but have some 78s you 
want to transfer to CD...no worries, our product can record a 78 at 45 speed and then 
just change the speeds for you to make it sound perfect.  That's just scratching the 
surface of what we can do...stay tuned.  Also, if you have extra money and aren't 
happy with your old turntable...again...no worries, thanks to DJs and a ton of people 
just like you, great companies like Stanton and Esoteric still create turntables that 
have quite a few 21st century bells and whistles.  They're not overpriced and we sell 
them at www.tracertek.com  

C. You'll need a preamp.  This seems trickier than it actually is.  Remember, most 
turntables don't generate enough signal to record at line level.  That's why, in the old 
days, you couldn't simply hook your turntable up to speakers and listen to it.  You had 
to plug it into a stereo system or at least a cassette deck to listen.  No different here.  
Your computer is set up to expect a line level signal, like the one generated by a tape 
deck or CD player.  You'll have to boost that signal with some sort of preamp.  If you 
have your old stereo system, you simply take the Tape Out RCA outputs and plug 
them into your sound card.  If you don't have your old stereo anymore and need this 
phono preamp, we sell affordable preamps with different flavors.  

D. You'll need a sound card.  Most computers already have a sound card on board.  If 
your computer came with speakers and you hear sounds every time you start 
Windows...you most likely have a sound card in your machine.  They usually have 
inputs and outputs on the front and back of most modern machines.  You'll see a 
panel that looks something like this: 

 

There are normally 2 or three holes depending on what type of computer you have 
(notebook, desktop) and what type of sound card you have.  Normally 3 holes mean that 
you have a microphone input (normally pink), a speaker output (normally green) and a 
Line Input (normally blue).  Some notebook computers only have a Mic Input and a 



speaker or headphone output.  If you have the three holed version, you're okay to get 
started.  You'll need the blue (Line Input) and of course, your speaker or headphone 
output so you can hear.  If you have the 2 holed version, you may need to invest in a 
better sound card to work with material directly from a turntable.  Also, it's important to 
note that most sound cards that are bundled with computers today are not of great 
quality.  But we're talking basics here, so if you have the three holes, let's move on.  If 
you only have two or want to investigate better sound cards, just contact Tracer and we 
can provide a sound card that meets your quality standards and your budget.   

E. You'll need our software.  Probably the most important part of the equation.  We 
offer several products that work with various versions of Windows and offer features 
of varying degrees, but for the most part, they all allow you to record your audio from 
the turntable through the line input on your sound card.  After recording, you have a 
selection of tools to remove noise like clicks, pops, hiss, surface noise, hum, buzz, 
and just about any other noise you can think of.  Then you have a selection of audio 
enhancement tools...far beyond the equalizers you're used to in the old days for 
breathing new life into your old recordings.  An finally, in most versions of our 
software, you can then transfer your audio to either CD, DVD or compressed formats 
like MP3 or WMA.  This is pretty important before we go on, so let's pick the product 
you need.  Here are your choices: 

 

 

Audio Mentor  

• Windows 2K, XP or Vista  
• The easiest product to use  
• Walks you through the entire process  
• Has restoration and enhancement as well as CD making (XP  

  and Vista Only) and MP3 support  
• Designed For A Beginner  
• Only $59  

Synopsis: 

Audio Mentor was designed for complete ease of use.  It walks the user through every 
step of the restoration process with complete onboard instructions called "Training 
Wheels.  Ideal for the beginner, it will talk you through hooking up your turntable, doing 
your first recording, restoration, enhancement and even spit out a CD, MP3 or WMA 
compressed file at the end.   



DC Millennium  

• Windows 95, 98SE, 2K, ME or XP  
• The oldest supported product  
• Very powerful interface  

• Allows multiple filters to be applied to multiple files simultaneously.  
• Ideal for customers with older versions of Windows and slow computers.  
• Only $59  

Synopsis: 

DC Millennium was created in 2000 and is still as powerful as most audio editors on the 
market today.  If you have an old machine, don't want to upgrade, but still want to restore 
and preserve your treasured recordings, then Millennium may be the ticket for you. 

 

DC SIX  

• Windows 98SE, 2K, ME, XP or Vista  
• Very powerful audio restoration and enhancement product.    
• Designed to be Faster, Easier to use, and more powerful than 

DC Millennium  
• The most powerful system available for folks with only 98SE, 2K or ME  
• $159 for download or $199 with 400-page paper manual.  

Synopsis: 

DC SIX was our flagship product up until November of 2007 when DC SEVEN shipped.  
This product is a "superset" of tools designed specifically for audio restoration and 
enhancement.  Of course today, the only reason to buy it is because you want the power 
and the ease of use, but don't have the desire to switch to XP or Vista and DC SEVEN. 

DC SEVEN  

• Windows XP or Vista  
• New Tune Library allows you to track and log every audio file 

on your hard disk  
• New Virtual phono preamp gives you the most accurate 

recordings available  
• Enhanced Decrackle  
• Every feature of the other versions is here, but better, more powerful and 

easier to use.  
• CD, MP3 and WMA making included  
• Only $159 for download or $199 with 400 page paper manual  



Synopsis: 

DC SEVEN is the newest flagship in our fleet of audio restoration and enhancement 
products.  You simply won't find a better solution on this planet for taking your old 
recordings and transferring them to CD or MP3 minus the noise of age.  All of the tools 
of previous versions are included, enhanced and optimized to be driven harder without 
generating artifacts.  This is one beefy upgrade!   

Chapter 2.  Getting Hooked Up 
Alright...we've got the basic components together now...let's get it hooked up.  Let's not 
make this job more complicated than it is.  You're basically substituting your computer's 
sound card for a tape deck.  Here are the steps...in no particular order.  

A.  RCA outputs of turntable to phono inputs of either a stand alone phono preamp or 
stereo amp.  

B.  RCA outputs of phono preamp or stereo amp to Line Inputs of sound card.  If you're 
using a bundled sound card, this is normally the 1/8" blue stereo input we showed you up 
above.  This normally uses a mini jack stereo plug like they use on a Walkman, I-Pod, or 
portable CD player.  You can purchase an RCA right and left to 1/8" stereo plug by going 
to the www.tracertek.com web site and ordering there. 

That's it.  Nothing too complicated here.  Outputs to Inputs...You should now be ready to 
launch your software (either demo version or purchased version) and make your first 
recording.   

Chapter 3.  Making Your First Recording 
Again, let's not make this too complicated.  Remember, we think of your computer like a 
big powerful tape recorder.  It is certainly more than that, but for recording, it's easiest to 
keep it simple.  

You may have downloaded one of four solutions...here are the steps required. 

For Audio Mentor...just follow the instructions.  Mentor is easy and set up to walk you 
through the entire process.  Make your first recording and then proceed.  You won't really 
need to revisit these instructions until Chapter 6...Expanding your Setup.   

For DC Millennium, DC SIX, and DC SEVEN...Though not as easy as Mentor, this is 
still not too complicated.  Just follow the instructions...don't overthink it, don't skip 
ahead, and you'll be fine. 

First, we should now have our hardware wired into our computer so we're ready to test.   



A.  Launch the software demo or purchased version.  Click through the various help 
windows, intro stuff and you should be staring a blank workspace that looks something 
like this:  

Important:  DC SEVEN will bring up the Tune Library and ask if you want to fill it up.  
For now, let's just cancel it.  DC SIX and Millennium will just come up blank. 

 

Now we simply click on the Record button.  This is the Red Circular button in the top 
row of all programs.  It is with the other transport controls and looks like this: 

 

Clicking on this Red Circular button will launch the Record Window.  This has gotten 
more feature-heavy from Millennium to SEVEN, but for the most part, it does just about 
the same thing.  Click on it now. 



 

This is the record window and hey, look at that...it's sort of like a tape recorder...these 
guys weren't kidding.  You'll see VU meters on the left that are sort of similar to those 
found on a tape deck, you'll see Pause, Rec and Stop buttons...nothing too science fiction 
here.  So let's make a recording.  First, we want to check the levels and see if your sound 
card is reading the audio coming in from your turntable.  Start your turntable playing 
through your preamp system...make sure everything's plugged in and turned on.  Hit the 
Pause button beside the record button.  This will turn on the VU meters and make sure 
we have sound.  (again, just like your tape decks in the old days.  You hit Pause and 
Record to turn on the meters)  In this case, you only need to press the pause button.   

If you have levels in the green anywhere from -20 up to the bottom of the yellow on 
the VU meters, you're good to go and ready to record.  Press the record button and 
record a song.   

Once you have levels and are recording, record a song and then hit the Stop button.  
You're almost there.  Just hit the Save button and give your new song a name.  It will now 
save the file to your hard disk and draw it on the screen for you.  You can skip ahead if 
things are working. 

If you have levels barely touching -50 at the bottom of the VU meters or no 
movement at all, you'll likely need to adjust your levels.  This is accomplished using the 
mixer software application that is provided by Windows and your sound card.  To access 
this mixer with a standard bundled sound card, just go to your systems tray (show below) 
and double click on the little gray speaker icon that should be there.  It looks like this: 

 



This speaker icon will launch your sound card's mixer, but you're not quite there yet.  
Most sound cards have 2 mixers onboard.  One sets the volume on output through the 
speakers and the other launches the recording mixer.  We want to make adjustments on 
the Line Input of the Recording mixer.   

Normally the mixer that opens by default is the Playback mixer, so we're going to have to 
click on Options/Properties (shown) 

 

And then Recording Mixer 

 



Keep in mind that this example is a standard sound card and Windows XP, which is still 
the most common Windows available.  The most important thing is finding the Recording 
Mixer...whether you're in a different version of Windows or have a different sound card 
mixer. 

The mixer will look something like this. 

 

We want to keep audio playing and find the Line In.  Make sure that it is selected and 
turned up.  The example above shows a common sight with the Mic Input activated.  You 
need to click on Line In and turn it up.  The software can stay active in Pause record, so 
keep that window up while you make adjustments on your mixer until you have levels in 
the green.  It should look like this. 

 



Important Note About Levels- Digital recording is not like analog recording as far as 
level meters go.  In the old days, we always let our level meters dance in the red to get the 
best recording level we could.  We were trying to compensate for the noise threshold of 
tape and cover that hiss that was an understood constant.  We no longer need levels of 
this magnitude.  If you have levels at -20, no big deal...it's plenty to get an accurate 
recording.  Green is good, yellow is okay, but not the best, and red is distortion.  In 
digital recording, avoid high levels.  Remember, we're going to be enhancing this audio 
with a full array of enhancement tools.  If you record with too much level, any 
enhancement you do will simply throw your wave recordings into distortion.  Leave some 
headroom and we'll adjust levels at the end of the process to make them perfect for your 
CDs or other recordings.   

  

If you still can't get levels.  Make sure you know where the problem lies.  Start with a 
simple recording...skip the turntable, preamp, etc. and plug a CD player with known line 
level output into your sound card.  This will tell you if in fact, your sound card is okay.  If 
you get levels, investigate the cables, preamp and turntable.   

Don't get too frustrated...remember the best part about Tracer.  You can call us and we'll 
help you.  866 ... will get you in touch with us and we usually answer all phone calls from 
9:00 to 5:00 EST Monday through Friday.  If those hours don't jive with your 
schedule...no big deal, send your questions to sales@tracertek.com or 
support@tracertek.com and we'll help you.  We will get you working, so don't sweat it.  
This is supposed to be fun. 

  

Once you have levels and are recording, record a song and then hit the Stop button.  
You're almost there.  Just hit the Save button and give your new song a name.  It will now 
save the file to your hard disk and draw it on the screen for you.  

Let's move on to the fun stuff... 

Chapter 4.  How The Tools Work 
Alrighty...we just made our first recording.  It should look like this: 



 

This is a healthy recording.  Not too robust, so we have room to enhance without 
distorting, we have a stereo file and we're looking at the system in our one screen Fast 
Edit Mode.  Seeing sound is a great thing.  Not only can we adjust and edit with our ears, 
but now we can see things that we may have not easily heard in the past.   

So, this is recording.  Not too bad, eh?   

Now let's start using the tools.  For that, we're going to start with a known file, rather than 
the one you just recorded, so just go to the file menu and click on File/Open Source 

 

Now we want to open an audio file to start the demo.  After DC SIX Opens, just click on 
File, then click on Open Source.  You’ll see a Window that looks like this:  



   

 

Next, open the Demo1 Wave file by double-clicking on it.     

Note:  Remember, this demonstration is applicable to DC Millennium, DC SIX or DC 
SEVEN, they may all not default to the correct directory.  If your computer doesn’t 
automatically open to this “Wavefiles” subdirectory, no worries.  In that case, simply 
click on the arrow pointing down just under the Open menu bar and beside the My 
Documents entry and navigate to C: (or whatever your main drive letter is) –Program 
Files-Diamond Cut Productions- Whichever product you have- Wavefiles and you’ll now 
see a screen that looks just like the one above.  It should have a wave file in it called 
Demo1.wav  

After you’ve opened the file, your DC SIX and Millennium should look like this:  

   



 

DC SEVEN launches in a single screen Fast Edit mode, but you should still see the 
waveform in the window.  It will probably be blue rather than black, but no big deal.     

Now we’re going to activate the transport system so that you can hear this file.   

  The transport system has 3 buttons that we’ll worry about right now. If 
you’ve ever worked with a standard cassette tape recorder, these will all seem very 
familiar to you.   

   

 This is the Record Button, we've already dealt with it in our first recording.  

   

 This is the Stop Button  

   

 This is the Play Button  

   

Listen to this file by either clicking the Play button or hitting the spacebar – Ouch, this 
file is full of clicks, hiss, low frequency noise, etc.  It’s a mess.   Stop the playback when 
you’re done listening.  You can do this by either hitting the space bar again or by using 
the Stop button.  



 

Now for the fun part:  Click the Filter Menu and choose EZ-Clean.  The filter looks like 
this: 

   

 

Important Note:  DC Millennium does not have EZ-Clean.  Just skip this tutorial and 
move to one that you can actually perform with the software.   

Notice that there are only three sliders, one for scratches or clicks, one for crackle (or 
small clicks) and another for hiss or other continuous type noises.  We are simply going 
to listen to the audio and move these three sliders as we listen.   

Move each slider to approximately the settings shown above.  We don’t need to be 
perfectly accurate, just set them similar to what you see.  When you move these sliders to 
the left, the filtering becomes more aggressive.  Now click the Preview button.  You’ll 
start to hear the audio.  

Listen for a second or two.  Now click the checkbox labeled Bypass.  This “bypasses” the 
filter and stops the filtering.  You are now hearing the original music without the filters in 
place.  Note the large amount of clicks and hiss.   Uncheck the Bypass box to start 
filtering again.  What a relief!  That’s much better isn’t it?  But, you can do better yet.   
Move the Hiss slider a bit farther to the left until you get all the noise out.   Remember, 
moving the sliders to the left, makes them filter more, so just slide them until you are 
happy with the result.  

   

Want to have some more fun?  Click on Keep Residue.  This filter lets you hear the noise 
that DC SIX is removing…some times, it’s easier to hear what you’re taking out than 
hearing what’s left.  This can be a useful tool when you’re close to finished and want to 
make sure you’ve removed only what you want to remove.  



Now note the Hum filter on the EZ-Clean screen.  If you live in the US, you’ll check the 
60hz box to remove power line hum.  If you live in Europe, you’ll check the 50hz box.  
There are many other tools to remove larger amounts of hum in DC Six, but this one is 
quick and easy.  

Now, stop the preview by clicking on the Cancel Button in the Preview box.  Click on 
Run Filter and you now have a destination file that is fully cleaned!   Could this possibly 
be any easier?  Note how visually different the before and after files are.  Hit Close on 
the EZ Clean.  You begin to see what “noise” actually looks like.  

   

 

   

Please continue on with the Easy Restoration guide below.  It starts your education on 
how to use individual tools and goes into more depth on the overall concept of DC Six.   

Easy Record Restoration Step By Step Guide  

Since EZ-Clean is so easy, you don’t really get a feel for the overall program.  This guide 
assumes you will use individual tools and will perform a restoration in a series of steps.   

You work with DC SIX by choosing filters to apply to audio.  Some of the filters remove 
noise and others enhance the audio though they are all referred to in this guide as filters.  
You choose a filter by identifying the type of noise you want to remove and then 
selecting the filter that removes that type of noise.  Make sense so far, right?  



In just about every case when clicks and pops are present, we want to remove them first.  
Trust us, this is the right first step whenever you get clicks and pops on records or other 
recordings.  

To remove the clicks, we’ll choose the EZ Impulse filter.  Clicks are short noise impulses 
so it makes sense to use this filter.  We’ll continue using the demo1.wav file.  Make sure 
that your top wave file is highlighted in yellow.  To choose the filter, click on the Filter 
menu item and choose EZ-Impulse Noise.  You’ll see the filter open like this:  

   

 

The EZ Impulse Filter Appears  

   

Note that the filter takes up only a portion of the screen.  You can still see part of the 
waveform and all the menus and icons.  You can move this filter window around on your 
screen and position it wherever you want.  Just grab the title bar at the top of the filter 
window and drag it around.  Try it now.  

   

   

 

The EZ Impulse Noise Filter  



   

In the filter window, you will see several features.  First, you’ll notice sliders that control 
various filter parameters.  These sliders can be adjusted while you listen to the audio as 
you did with the EZ Clean filter, so you will instantly hear the result of any changes you 
make.  Our sliders are labeled Scratch and Crackle in this filter.  

   

Next, you’ll have Radio buttons that control other aspects of the filters.  Again, you can 
change them while listening, so you’ll hear the results instantly.  The radio buttons in the 
Impulse filter are Speed and Accuracy.  

   

In every filter, just like our EZ Clean demo, you will have a Preview button.  This is the 
most important button here.  This button will start the audio playing while the filter is 
processing it.  You will hear the results of the filter instantly.  This makes for easy 
adjustment of the filters.  

   

Also in every filter, you will have a Bypass checkbox.  This takes the filter in and out of 
the audio stream instantly.  When you listen to a filter being applied by the Preview 
button, you may want to be able to compare the processed audio to the original audio.  
Clicking this checkbox will bypass the filter and you’ll be hearing the original audio.  
Unchecking it will instantly put the filter back into the signal path.  This way, you can 
“fine tune” even subtle effects with DC SIX.  

   

Lastly, every filter will have controls for Presets.  A preset is a saved group of settings for 
this filter.  Go ahead and drop down the Preset box now – it’s the white box at the 
bottom of the filter.  Click on some of the presets and watch the sliders as they move to 
good starting points for common tasks.  You can tell a lot by looking at the name of the 
presets.  Now select the preset labeled Default.  This one is already set up with good 
settings for our Demo1 file.  Every filter will also have a Save and Delete button that 
allows you to save your own presets under any name you want – and delete them too!  

   

You’re probably ready to try this filter by now, but there is one more thing that is 
common to each filter that you should know.  Hit F1 now on your keyboard.  Notice that 
our online Help comes up with information on this specific filter.  This context sensitive 
help is available for each and every filter.  



   

Put the Help screen away and let’s clean some audio.  If you’ve already been listening to 
this filter, then shame on you for jumping ahead.  Simon has not said click the Preview 
button yet.  As punishment, please go back to page one of this tutorial and start reading 
again.  We’ll wait for you here.  

Welcome back.  Now let’s get started by clicking the button labeled Preview.  You will 
hear the audio as it is being filtered.  You will still hear the low frequency rumble and the 
hiss, but the clicks should be gone.  Let it preview all the way to the end of the file.  
Notice that once it reaches the end, it will automatically start over at the beginning.  This 
is called Looping and is automatic when you are previewing with a filter (though it can 
be turned off in the Edit/Preferences screen).  

Let’s just confirm that the clicks are gone.  To do this, check the Bypass box in the filter 
while it is still previewing.  Now the filter is bypassed and the clicks will once again be 
audible.  Listen for a while and then uncheck the Bypass box.  Now the filter is again 
doing it job and the clicks are no longer heard.   

It’s time to learn how to adjust a filter.  While you are previewing, move the two sliders 
to the bottom.  This makes the filter less aggressive and it will filter less.  Notice that the 
clicks return as the sliders are moved down.  Moving them back up results in more and 
more of the clicks getting removed.  All the filters work this way – you just adjust them 
while you listen.  As you might expect, if you move them too far up you’ll make the filter 
too aggressive and you’ll get distorted, stuttering or otherwise bad audio – just move 
them up enough to get the desired result.  Set them both at 50.  

Now click on Cancel in the Progress window seen here or just click the Preview button 
again:  

   

 

Monitor your progress  

This stops the preview from playing.  By Previewing, we have adjusted the filter and 
confirmed that it is doing its job.  The next step is to click on the Run Filter button.  This 
takes the filter just as you have set it and applies it to the demo1 file and creates a new 
file in the lower window.  This new file has been run through the filter and has the clicks 
removed. At this point, click on Close in the EZ Impulse filter window since we’re now 
done with it.  

   



Look at the two waveforms.  The top one is called the Source.  This is where we normally 
work on a file, preview filters, etc.  The bottom is called the Destination and is the result 
of our filtering efforts.  You can play either one by clicking in the respective window.  
You have not changed your original file at all – rather we’ve created a new cleaned up 
version.  

   

Now it’s time to remove that rumble sound, but how can we do that if we work on the 
Source window  and we really want to remove the rumble from the semi-clean file in the 
Destination window?  The answer is a little command under the File menu called Make 
Destination the Source.  This moves the file in the bottom window up to the top where we 
can work on it.  Click on File/Make Destination the Source now.  

A File Selector box will come up and suggest a new name for this file; just click on Save 
to accept it.  Note:  DC SIX will automatically assign sequential names to new files.  
While you’re new to the program, always just accept its recommendation as to file 
names.  

Now we are ready to remove that low frequency rumble.  To do that, we’ll choose the 
High Pass filter.  Click on Filter/High Pass now.  A high pass filter will remove all 
frequencies below a certain point and allow all higher frequencies to pass.    Drop the 
preset box and select the preset called “Demo audio Wave file de-rumble”.  It’ll look 
like this:  

   

 

The Highpass filter  

   

We’ll start to go a bit quicker now since you already know what most of the buttons and 
controls do on this filter.  To find out specific info on this filter, don’t forget you can call 
for help by pressing the F1 key.  We are going to free you now to preview and play with 
this filter on your own, but when you’re done, return it to these settings by once again 
clicking on the demo Wave file preset.  Run the filter when you are ready.  Now click on 
Close to close this filter.  

   



You now have removed two of the annoying noise types in this file.  First, we rid 
ourselves of the clicks and pops, and then we removed the rumble.  Now it’s time to get 
rid of that loud hiss sound.  First, remember to move our Destination file up to the 
Source window.   

Now click on Filter and select the Continuous Noise Filter.  This filter is perfect for 
hiss and other types of continuous noise.  Also, click on View and make sure you have 
Time Display checked at this time.  The Time Display box shows you various timing 
calculations with the program and will come in handy, as you will see.  Your screen 
should look something like this:  

   

 

The Continuous Noise filter is awake  

   

The Continuous Noise filter is one of the coolest in the whole program so follow along 
carefully here.  This filter will remove just about any continuous noise in a program, but 
it needs you to give it a sample of this noise.  Once it is able to examine the noise, it will 
be able to seek it out and get rid of it.  Play the file now using the Play button at the top 
and listen carefully to the first couple of seconds.  You will hear an area right at the 
beginning, which contains only the noise and no good audio.  That’s a great spot from 
which to grab a sample of the noise.    

To do this, we need to click and drag with our mouse to select this area.  The area 
highlighted in yellow in the illustration above is the area we want to select.   Just click 
about ½ inch from the left edge and, while holding the mouse button, drag all the way 
left.  Let the mouse button go and you will see an area highlighted in bright yellow.  This 
is the area you have selected.  Move the mouse pointer over either edge of the selected 
area and the pointer will turn into a Left/Right indicator.  Click and drag as necessary to 
select an area from the beginning of the file that is about .5 seconds long.  Use the 
“Span=” display in the timer window to confirm that your selection is around ½ second 
long.  



   

Now hit the spacebar.  You’ll play only the selected area.  It’ll be quick.  This allows you 
to audition a selected area to make sure you are really working on the correct area (does 
not contain silence or desired signal).  You should only hear the hissing noise.  Again, 
your selected area should look like the one shown above.  

It’s time for the fun part.  You will like this.  Hit the Sample Noise  button in the Filter 
window.  The filter will analyze the noise sample and will display the frequency 
characteristics of the noise in red.  The blue line is the filter that has been designed to get 
rid of this noise.  Notice how they track with each other.   Yours should look like this:  

   

 

Continuous Noise Filter does its job  

If you have jumped ahead again and clicked on Preview, there will be no lunch for you 
today.  First, we’ve got to explain those little blue dots on the filter line.  Notice how the 
blue line is above the red noise sample?  The higher the blue filter line, the more filtering 
occurs at that frequency.   The blue dots are called Control Points  and allow you to 
adjust the amount of filtering for frequency components in the vicinity of the control 
point manually.  We’re going to do that in a second, but the Help file contains all the 
complete info on this filter.  

Before we click on Preview, we need to again select the whole file so we’ll hear the 
whole thing and not just our ½ second noise sample that is now selected.  To select the 
whole file, just double click anywhere in the waveform display.  Notice how the whole 
thing gets highlighted in yellow.  Now, go ahead and click on Preview.   

Listen to the audio.  The clicks are gone.  The rumble is gone and the hiss is gone!  Well, 
not quite.  You can still hear a bit of hiss can’t you?  While Previewing, click the bypass 
button a few times to take the filter in an out of the signal path.  Yes, the hiss is reduced, 
but there is still some of it there.  Let’s adjust this filter to get rid of all of the hiss.  



   

Make sure your bypass button is NOT checked and make sure you are previewing the 
audio.  Now grab the 2nd control point from the right side and move it up a bit as shown 
below.  

   

 

Tackling the remaining hiss  

   

It’s like magic, isn’t it?  The hiss completely goes away because you told the filter to be a 
bit more aggressive on the high frequencies.  Remember, moving the blue line up makes 
it filter more.  Now stop the preview, click on Run filter, and close the Continuous 
Noise filter.  

You now have a Destination file that is completely restored.  To finish, click on 
File/Make Destination the Source, accept the file name and you’re done.  This file is 
the completed version and all others can be deleted or saved if you want each processing 
step before and after the saved file.  You can now exit the program or close the files using 
the commands under the File Menu. 

Let's finalize things a bit...you can skip the Millennium Getting started guide and go to 
the Chapter 5.   

   

DC Millennium Comprehensive Guide  

As we've stated before, DC Millennium is an older product, but if you're clinging to 
Windows 98, then you still have a powerful noise reduction product at your disposal.  
The process of cleaning up your demo file is virtually the same as with our newer 
software products, so let's get it on.    



First, let's remove some of those annoying clicks.  Just go to the Filter menu and launch 
the Impulse filter.  It looks like this: 

 

And when it launches, it looks like this: 

 

All of the filters in our programs work about the same. You have a Preview button, which 
auditions the audio with the filter you've set up in place.  This is where you experiment 
with the filters while you listen to the changes in realtime.  Go ahead and click on 
Preview.  Slowly move the sliders to the following positions: 

 



Do you hear the noise disappearing?  That's how easy it is.  Preview dials it in and then 
when you've got it sounding good, you hit Preview again to stop playback and then Run 
Filter to make a new file that is what you just heard.  It looks like this: 

 

The lower window is called the Destination Window.  This is where the results of your 
filtering are placed after you run the filter. Notice the difference in appearance?  All of 
the big spikes are now gone.  Those spikes were clicks.  We still have a way to go to 
make this song sound great, but clicks are not our problem anymore.   

Now we want to take the file on the bottom and do some more work on it.  The top 
window is called the Source window and that is always the file we're working on.  If we 
want to continue, the first thing we have to do is move the wave file in the bottom to the 
Source window so we can continue on our quest to perfect that wave file.  To do this just 
go to the File Menu and click Make Destination The Source.  It looks like this: 

 



This simply moves the wave file onto the operating table so that we can continue work on 
it.   

Our next step is to work on that annoying continuous hissing we hear on this file.  
Continuous noise means the Continuous Noise Filter.  Just go to the Filter Menu and 
click on Continuous Noise Filter.  It looks like this: 

 

When it launches, it will look like this: 

This filter is perfect for hiss and other types of continuous noise.  Also, click on View 
and make sure you have Time Display checked at this time.  The Time Display box 
shows you various timing calculations with the program and will come in handy, as you 
will see.  Your screen should look something like this:  

   

 

The Continuous Noise filter is awake  



The Continuous Noise filter is one of the coolest in the whole program so follow along 
carefully here.  This filter will remove just about any continuous noise in a program, but 
it needs you to give it a sample of this noise.  Once it is able to examine the noise, it will 
be able to seek it out and get rid of it.  Play the file now using the Play button at the top 
and listen carefully to the first couple of seconds.  You will hear an area right at the 
beginning, which contains only the noise and no good audio.  That’s a great spot from 
which to grab a sample of the noise.    

To do this, we need to click and drag with our mouse to select this area.  The area 
highlighted in yellow in the illustration above is the area we want to select.   Just click 
about ½ inch from the left edge and, while holding the mouse button, drag all the way 
left.  Let the mouse button go and you will see an area highlighted in bright yellow.  This 
is the area you have selected.  Move the mouse pointer over either edge of the selected 
area and the pointer will turn into a Left/Right indicator.  Click and drag as necessary to 
select an area from the beginning of the file that is about .5 seconds long.  Use the 
“Span=” display in the timer window to confirm that your selection is around ½ second 
long.  

Now hit the spacebar.  You’ll play only the selected area.  It’ll be quick.  This allows you 
to audition a selected area to make sure you are really working on the correct area (does 
not contain silence or desired signal).  You should only hear the hissing noise.  Again, 
your selected area should look like the one shown above.  

It’s time for the fun part.  You will like this.  Hit the Sample Noise  button in the Filter 
window.  The filter will analyze the noise sample and will display the frequency 
characteristics of the noise in red.  The blue line is the filter that has been designed to get 
rid of this noise.  Notice how they track with each other.   Yours should look like this:  

   

 

Continuous Noise Filter does its job  

   



If you have jumped ahead again and clicked on Preview, there will be no lunch for you 
today.  First, we’ve got to explain those little blue dots on the filter line.  Notice how the 
blue line is above the red noise sample?  The higher the blue filter line, the more filtering 
occurs at that frequency.   The blue dots are called Control Points  and allow you to 
adjust the amount of filtering for frequency components in the vicinity of the control 
point manually.  We’re going to do that in a second, but the Help file contains all the 
complete info on this filter.  

   

Before we click on Preview, we need to again select the whole file so we’ll hear the 
whole thing and not just our ½ second noise sample that is now selected.  To select the 
whole file, just double click anywhere in the waveform display.  Notice how the whole 
thing gets highlighted in yellow.  Now, go ahead and click on Preview.   

Listen to the audio.  The clicks are gone.  The rumble is gone and the hiss is gone!  Well, 
not quite.  You can still hear a bit of hiss can’t you?  While Previewing, click the bypass 
button a few times to take the filter in an out of the signal path.  Yes, the hiss is reduced, 
but there is still some of it there.  Let’s adjust this filter to get rid of all of the hiss.  

Make sure your bypass button is NOT checked and make sure you are previewing the 
audio.  Now grab the 2nd control point from the right side and move it up a bit as shown 
below.  

   

 

 Tackling the remaining hiss  

   

It’s like magic, isn’t it?  The hiss completely goes away because you told the filter to be a 
bit more aggressive on the high frequencies.  Remember, moving the blue line up makes 
it filter more.  Now stop the preview, click on Run filter, and close the Continuous 
Noise filter.  

   



You now have a Destination file that is completely restored.  To finish, click on 
File/Make Destination the Source, accept the file name and you’re done.  This file is 
the completed version and all others can be deleted or saved if you want each processing 
step before and after the saved file.  You can now exit the program or close the files using 
the commands under the File Menu. 

Chapter 5.  Finishing The Project 
Now that we've removed the noise, there may still be several things you want to try 
before you either burn this to CD, MP3 or WMA.  There is a full set of enhancement 
features provided in all of the products.  Like most things...we've improved them over the 
years, so DC SEVEN will be the best, followed by SIX, then Mentor and finally 
Millennium.  All four products are powerful tools, so you'll have plenty of features in all 
of them.  You can find them in the Effects and Filters menus.  They range from simple 
10-Band EQs to complex tube simulators and other professional tools.  Just like the noise 
reduction features we've just studied, you have a Preview button to check out the filter, a 
bunch of presets you can choose and a Run Filter when you're happy with the results.  
Have fun and make a mess.  

Now you've reached the point where you've taken an old recording and breathed new life 
into it while also subtracting the noise of age and old recording techniques.  Depending 
on the product you've chosen here's how you get to where you want to go. 

DC SEVEN- Burns CDs WMAs, and MP3s within the product.  Just follow the 
instructions. 

Audio Mentor- Burns CDs WMAs and MP3s within the product.  Just follow the 
instructions. 

DC SIX- Can make MP3s using a secondary converter.  Follow instructions.  Does not 
burn CDs...you'll need to use Windows Media Player or your standard onboard CD 
making software.  Your software will recognize the .wav files that SIX makes, so all you 
have to do is tell it you want an Audio CD and point it to your directory of cleaned wave 
files.  It will do the rest. 

DC Millennium-  Does not make CDS or MP3s.  You'll need to download a converter to 
turn the .wav files it makes into either MP3, WMAs and you'll need to use Windows 
Media Player or your standard onboard CD making software.  Your software will 
recognize the .wav files that Millennium makes, so all you have to do is tell it you want 
an Audio CD and point it to your directory of cleaned wave files.  It will do the rest.  

Chapter 6.  Expanding Your Setup 
What we've covered in chapters 1-5 are the basics.  It may seem like a lot, but once 
you've waded through it, it's pretty basic.  Probably the hardest thing about the entire 



process is training your ears to pick the noise you want to remove and using the right tool 
to remove it.  We have some very good educational tools to help with this process as well 
as lots of things you can do to make your system produce better results.  That's what we'll 
cover here: 
• Education 
Of course, like any tools, there's no substitute for simply using these products and 
learning by doing.  But Tracer also offers a full lineup of DVDs that are basically set up 
so that it seems like you've invited an expert into your living room to show you around 
the product.  Our training DVDs are fun, they're easy to understand, and they have more 
meat than a butcher.  They're also affordable.  For restoration and enhancement, we offer 
3 flavors.  

Audio: The Movie:  This 2 hour DVD explores audio in great detail, but explains the 
science behind audio without a bunch of mathematics and complex theories.  You will 
have a better understanding of the terms used, understand MP3 and CDs and why things 
are the way they are.  It's a great educational experience for 39 bucks!  Want to learn 
more about it?  Go to www.tracertek.com  

Understanding A Continuous Noise Filter-  No one filter is used harder in all of our 
noise reduction products than the CNF.  This tutorial helps you understand how it works 
and how to get the best results using it.  It's only $19.99 and well worth that price.  Want 
to learn more about this DVD?   Go to www.tracertek.com 

Everyone's Guide To Better Audio Using DC SEVEN-  Our latest product is the topic 
of this 2 hour DVD.  You'll see advanced tutorials on all of the new features of the 
product and also complete 2 full restorations.  This is perfect for the beginner or the 
advanced user to help you grasp the breadth of this powerful product.  Only $39 or $29 
when bundled with DC SEVEN.  Want to learn more?   Go to www.tracertek.com  

• Record Cleaning 
Cleaning your records can help you get a much better recording out of the gate and much 
less noise to reduce with the software.  We sell a range of products that start at about 50 
bucks and go to fully automated very cool machinery at about 600 bucks.  All of the 
products we sell will clean your records, make them sound better and put less wear and 
tear on your stylus.   Go to www.tracertek.com for more info! 
 
• Record Storage 
If you're going to take the time to clean your records, it might also be time to find them a 
new home.  Of course you don't want to throw away that classic album cover, but we 
have a full supply of new white inner sleeves for 45s, 78s, and albums as well as some 
very cool protection for your collection.  Go to www.tracertek.com for more info! 
 
• Speakers and Headphones 
If you're going to be listening to lots of audio in the coming months...you may want to 
improve your listening system around the old computer.  That cheesy set of speakers that 
came with your PC is fine for the beeps and boops of everyday life, but for real audio, 



you can get some pretty cool listening stuff that isn't all that expensive.  Click Here To 
Find Out More About Speakers or Headphones  Go to www.tracertek.com  
 
• Turntables and Supplies 
If your old turntable is not cutting it, you'd be amazed at how little it costs you to replace 
it with a 21st century alternative.  Our turntables are heavy duty, dependable and we also 
sell some cartridges and other turntable supplies if you need them.   Go to 
www.tracertek.com for more info! 
 
• Flat Phono Preamps 
There's probably a lot you didn't know about how records are made and how most stereo 
systems add a hard coded EQ curve to every record you hear.  This EQ is not very 
accurate and in most cases, is not playing your records back correctly.  In a world where 
we now record our audio to powerful computers that can take this necessary EQ curve 
and reproduce it perfectly, a new age of phono preamps is born.  They don't add any 
colorization at all to your audio and the results are fantastic.  These flat phono preamps 
are priced affordably but can make a huge difference in your restorations.  Go to 
www.tracertek.com for more info! 


